
♦ Please read this manual before operating this scanner.

User Manual
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FCC REGULATIONS (For 120V model)
Check Reader, Model 6130110/6130120
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: (1) This device 
may not cause harmful interference, and (2) this device must accept any interference received, including interference 
that may cause undesired operation.
Note: This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part 
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in a 
residential installation. This equipment generates, uses, and can radiate radio frequency energy and, if not installed and 
used in accordance with the instructions, may cause harmful interference to radio communications. However, there is 
no guarantee that interference will not occur in a particular installation. If this equipment does cause harmful 
interference to radio or television reception, which can be determined by turning the equipment off and on, the user is 
encouraged to try to correct the interference by one or more of the following measures: 
- Reorient or relocate the receiving antenna. 
- Increase the separation between the equipment and receiver. 
- Connect the equipment into an outlet on a circuit different from that to which the receiver is connected. 
- Consult the dealer or an experienced radio/TV technician for help. 
Use of shielded cable is required to comply with class B limits in Subpart B of Part 15 of FCC Rules.
Do not make any changes or modifications to the equipment unless otherwise specified in the manual. If such changes 
or modifications should be made, you could be required to stop operation of the equipment. 
Canon U.S.A. Inc.
One Canon Park, Melville, NY 11747, U.S.A.
Tel. No. (800)652-2666

RADIO INTERFERENCE REGULATIONS (For 120V models)
This digital apparatus does not exceed the Class B limits for radio noise emissions from digital apparatus as set out in 
the interference-causing equipment standard entitled “Digital Apparatus”, ICES-003 of the Industry Canada.

RÈGLEMENT SUR LE BROUILLAGE RADIOÉLECTRIQUE (For 120V 
models)
Cet appareil numérique respecte les limites de bruits radioélectriques applicables aux appareils numériques de Classe 
B prescrites dans la norme sur le matériel brouilleur: “Appareils Numériques”, NMB-003 édictée par l’Industrie Canada.

ENERGY STAR® Office Equipment Program
This program is for U.S.A and Canada.
As an ENERGY STAR® Partner, CANON ELECTRONICS INC. has determined that this machine meets 
the ENERGY STAR® Program guidelines for energy efficiency.
The ENERGY STAR® Office Equipment Program is an international program that promotes energy 
saving through the use of computers and other office equipment. The program backs the development 

and dissemination of products with functions that effectively reduce energy consumption. It is an open system in which 
business proprietors can participate voluntarily. The targeted products are office equipment, such as computers, 
monitors, printers, fax, machine, copiers, and scanners. The standards and logos are uniform among participating 
nations.

This model doesn’t provide “setting options” for power management.

European Union (and EEA) only.
This symbol indicates that this product is not to be disposed of with your household waste, according to 
the WEEE Directive (2002/96/EC) and your national law. This product should be handed over to a 
designated collection point, e.g., on an authorized one-for-one basis when you buy a new similar product 
or to an authorized collection site for recycling waste electrical and electronic equipment (EEE). Improper 
handling of this type of waste could have a possible negative impact on the environment and human 

health due to potentially hazardous substances that are generally associated with EEE. At the same time, your 
cooperation in the correct disposal of this product will contribute to the effective usage of natural resources. For more 
information about where you can drop off your waste equipment for recycling, please contact your local city office, 
waste authority, approved WEEE scheme or your household waste disposal service. For more information regarding 
return and recycling of WEEE products, please visit www.canon-europe.com/environment.
(EEA: Norway, Iceland and Liechtenstein)

Für EMVG
Dieses Produkt ist zum Gebrauch im Wohnbereich, Geschäfts-und Gewerbebereich sowie in Kleinbetrieben 
vorgesehen.

Model Names
The following names may be provided for the safety regulations in each sales region of the Check Reader.
CR-L1: 6130110
CR-L1 UV: 6130120

Trademarks
• Canon and the Canon logo are registered trademarks, of Canon Inc. in the 

United States and may also be trademarks or registered trademarks in other 
countries.

• imageFORMULA is a trademark of CANON ELECTRONICS INC.
• Microsoft, Windows, Windows 7, Windows 8.1 and Windows 10 are registered 

trademarks or trademarks of Microsoft Corporation in the United States and 
other countries.

• Microsoft product screen shot(s) reprinted with permission from Microsoft 
Corporation.

• Adobe and Adobe Reader are registered trademarks or trademarks of Adobe 
Systems Incorporated in the United States and other countries.

• Other product and company names herein are, or may be, the trademarks of 
their respective owners.

Copyright
Copyright 2018 by CANON ELECTRONICS INC. All rights reserved.
No part of this publication may be reproduced or transmitted in any form or by any means, electronic or mechanical, 
including photocopying and recording, or by any information storage or retrieval system without the prior written 
permission of CANON ELECTRONICS INC.

Reproduction Warning
This device is designed to be used in a legal manner, in accordance with all applicable laws, including, but not limited 
to, counterfeit and copyright laws, as well as laws pertaining to national security.
Any person(s) found to have reproduced any of the following materials (regardless of whether such reproduction was 
intentional or not) for the purpose of misrepresenting such material as the original may be prosecuted in accordance 
with the applicable laws and regulations.
• Paper money or bank notes (domestic and foreign)
• Postage stamps, revenue stamps, or other similar stamps
• Stock certificates, bond certificates, promissory notes, cheques, or other valuable certificates
• Passports, licenses, or other certificates or documents issued by government officials or agencies
This is not an exhaustive list.
Canon is not responsible for how this scanner is used by an individual. 
Please note that certain intellectual property is protected by copyright law, and copyrighted items may not be 
reproduced without the express permission of the copyright holder except for personal or household use under limited 
circumstances.
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Disclaimers
The information in this document is subject to change without notice.

CANON ELECTRONICS INC. MAKES NO WARRANTY OF ANY KIND WITH REGARD TO THIS MATERIAL, EITHER 
EXPRESS OR IMPLIED, EXPECT AS PROVIDED HEREIN, INCLUDING WITHOUT LIMITATION, THEREOF, 
WARRANTIES AS TO MARKETABILITY, MERCHANTABILITY, FITNESS FOR A PARTICULAR PURPOSE OF USE OR 
NON-INFRINGEMENT. CANON ELECTRONICS INC. SHALL NOT BE LIABLE FOR ANY DIRECT, INCIDENTAL, OR 
CONSEQUENTIAL DAMAGES OF ANY NATURE, OR LOSSES OR EXPENSES RESULTING FROM THE USE OF THIS 
MATERIAL.

CANON ELECTRONICS INC. IS NOT LIABLE FOR THE STORAGE AND HANDLING OF DOCUMENTS SCANNED WITH 
THIS PRODUCT, OR THE STORAGE AND HANDLING OF THE RESULTING SCANNED IMAGE DATA.
IF YOU INTEND TO DISCARD THE ORIGINALS OF THE SCANNED DOCUMENTS, YOU ARE RESPONSIBLE FOR 
INSPECTING THE SCANNED IMAGES AND VERIFYING THAT THE DATA IS INTACT.
THE MAXIMUM LIABILITY OF CANON ELECTRONICS INC. UNDER THIS WARRANTY IS LIMITED TO THE PURCHASE 
PRICE OF THE PRODUCT COVERED BY THE WARRANTY.

Make sure that you have everything shown below. Check every item you have 
removed from the box. If any items are missing, contact your local authorized 
Canon dealer.

NOTE
Items included in this package may change without any notice.

Packaging: What Is in the Box?

CR-L1

Disc Power Cord*1

Warranty Card*2

USB Cable

AC Adapter

Marking Labels 
for Thickness 

Adjustment Dial

*1 The power cord varies, according to the country of purchase.
*2 For the United States and Canada only.

Setup & Operation Guide
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Preparation Before Use

This chapter describes how to prepare the scanner to scan documents.

Perform the following steps to set up the CR-L1. Refer to the section for each 
step for details about that step.

A Check your operating environment. (See “Checking Your 
Operating Environment,” on p. 5.)

B Install the software. (See “Installing the Software,” on p. 5.)
Install the Scanning Utility provided with the CR-L1.

C Connect the scanner to a computer. (See “Connecting the 
Scanner to a Computer,” on p. 6.)

D Turn ON the power. (See “Turning ON the Power,” on p. 7.)

E Automatically installing the device driver. (See p. 7.)
The device driver is installed automatically when Windows recognizes the 
CR-L1.

IMPORTANT
• To have the device drivers installed automatically when the computer recognizes 

the CR-L1, the software needs to be installed before the CR-L1 is connected to the 
computer.

• If you connect the computer and turn ON the CR-L1 before installing the software, 
the following wizard screen appears. If this happens, click [Cancel], turn OFF the 
CR-L1, and then install the software.
The following wizard screen is an example in Windows 7. When a similar wizard 
screen appears in Windows 8.1/10, click [Cancel]. 

Setting Up the Scanner

Wizard Screen (Windows 7)
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The following computer system requirements are recommended for using the 
CR-L1.

Operating Systems:
• Microsoft Windows 7 (32/64bit) SP1 or later
• Microsoft Windows 8.1 (32/64bit) 
• Microsoft Windows 10 (32/64bit) 
• Microsoft Windows Server 2008 R2 Service Pack 1 or later
• Microsoft Windows Server 2012 R2
• Microsoft Windows Server 2016
• Microsoft Windows Server 2019
This is the environment as of December 2018.
For the latest software support information, go to the Products page on the 
Canon website.

Specifications:
• CPU: Intel Core2 Duo 1.8 GHz or faster
• Memory: 1 GB or more
• USB 2.0 interface

Interface Cable
• Use the cable provided or a Hi-Speed USB 2.0 interface cable to connect to 

the computer’s USB port.

• Scanning speed may vary depending on the specifications of your computer.

IMPORTANT
• If you use the USB interface that was provided as standard with your computer:

• Use the most recently available USB 2.0 driver provided by Microsoft. Contact 
your local authorized Canon dealer for more detailed information.

• Not all USB interfaces provided as standard with personal computers are 
guaranteed. Contact your local authorized Canon dealer for more detailed 
information.

• Scanning speeds are slower if your computer’s standard USB interface is USB 
1.1.

• You should use the USB cable originally bundled with the scanner or a Hi-Speed 
USB 2.0 compatible cable.

• If the CPU, memory, interface card, and other specifications do not satisfy the 
installation requirements, the scanning speed may be greatly reduced and 
transmission may take longer.

• Even if the computer satisfies the recommended specifications, the scanning 
speed may vary, depending on the scan settings.

The following software applications are provided on the website.
There are 2 usable software applications.
For the latest software support information, go to the Products page on the 
Canon website.

Canon Driver
The Canon Driver is the Canon original standard driver. You need this driver 
to use the Scanning Utility.

Scanning Utility
Canon Scanning Utility is an application that provides scanning, file saving, 
image viewing, printing, and various other functions. A dedicated scanner 
driver is installed after you install the utility software.

IMPORTANT
• The Scanning Utility includes a device driver so that Windows can recognize the 

CR-L1. Be sure to install the Scanning Utility before connecting the CR-L1 to the 
computer.

• Some functions mentioned in this manual may not be operated in some 
applications.

Installing the Scanning Utility
Follow the instructions below to install the Scanning Utility and the dedicated 
driver.

NOTE
The dedicated scanner driver is installed after the Scanning Utility has been installed.

A Turn ON your computer, and log on to Windows.

IMPORTANT
Be sure to log on as the Administrator.

B Download usable software from the Canon Website.
After executing the downloaded file, follow the instructions on the screen 
to complete the installation.

IMPORTANT
• The displayed screen, type, file name, and folder name will differ depending on 

your environment or purpose. These items should be replaced as necessary.
• The computer may need to be restarted, after the installation, depending on the 

operating system. If this is necessary, make sure to restart the computer.

Checking Your Operating Environment Installing the Software
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The only way to connect the scanner to your computer is with a USB cable.

IMPORTANT
• Be sure to use the USB cable bundled with the scanner or a Hi-Speed 

USB 2.0 compatible cable with the length less than 5 m.
• When the application is running, do not turn the scanner OFF or unplug the interface 

cable.
• Do not connect multiple CR-L1 scanners to one computer.

CAUTION
• Do not turn OFF the scanner or remove the interface cable when an application 

is running.
• Turn OFF the computer and the scanner before changing the cable.

USB Connections
Connect the scanner and the computer with the cable provided or a Hi-Speed 
USB 2.0 cable.

NOTE
Connect the type B plug (square) to the scanner and connect the type A plug (flat) to 
the USB port on the computer.

Connecting the Power Cord
Connect the power cord.
Make sure to use only the power cord provided with the scanner.

WARNING
When connecting the power cord, follow these precautions. Failure to do so may 
cause a fire or electrical shock.
• Never grasp the power plug when your hands are wet.
• Never plug the scanner into a multiplug power strip.
• Never bundle or tie the power cord around itself or another object. Connect the 

power plug securely into the power outlet.
• Use only the power cord and power plug provided with the scanner.
• Before you connect the power cord, make sure to turn OFF the power switch.
• Connect only to a power outlet of the rated voltage and power supply frequency (either 

120V, 60 Hz or 220-240V, 50/60 Hz, depending on your region).
• Do not plug the scanner into a power outlet shared with another device. If you 

use an extension cord, make sure that the extension cord is rated for the 
current requirements of the scanner.

Connecting the Scanner to a Computer

Type B Plug Type A Plug

USB 
Connector



7

Follow the procedures below to turn the scanner power ON and OFF.

Turning ON the Power
A To turn ON the scanner, slide the Power Switch to the right.

IMPORTANT
• When you turn ON the power, the power LED flashes slowly, and then turns solid.
• If the scanner does not work, there is a problem with the scanner. Turn OFF the 

power, and contact your local authorized Canon dealer or service representative to 
have the scanner serviced.

WARNING
If you hear strange sounds, detect smoke or abnormal heat, sense a vibration, 
or smell odd odors around the scanner, turn OFF the power immediately and 
disconnect the power cord from the power outlet. Contact your local authorized 
Canon dealer or service representative to have the scanner serviced.

B Windows recognizes the CR-L1 as new hardware, and installation 
starts automatically.

NOTE
The CR-L1 will be registered as “CANON CR-L1 USB” in the Imaging Device 
directory.

Turning OFF the Power
A Turn OFF your computer.

B To turn OFF the scanner, slide the Power Switch to the right.

CAUTION
• Wait at least 10 seconds before turning the scanner back ON.
• For your safety, disconnect the power plug from the power outlet if you are not 

using the scanner for a long period of time.

NOTE
The scanner’s auto power off setting is enabled by default, and the scanner will 
turn off automatically if it is not operated for 4 hours. For details on how to 
disable this setting, see “Auto Power Off,” on p. 27

Turning ON and OFF the Power

(ON)

 (Windows 7)

(OFF)
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INTRODUCTION

Thank you for purchasing the Canon Check Reader CR-L1.
Please read this manual thoroughly before using the machine in order to 
familiarize yourself with its capabilities, and to make the most of its many 
functions. Unless otherwise noted, CR-L1 is used for both the CR-L1 and the 
CR-L1 UV models, throughout this manual.

Manuals for the CR-L1
The following manuals are provided with the CR-L1. Be sure to read these 
manuals thoroughly before using the scanner. (The Setup & Operation Guide  
extracted from the User Manual.) Electronic manual is stored as a PDF file on 
the supplied Setup Disc and requires Adobe Reader to open. (You can 
download Adobe Reader from the Adobe Web site.)

Setup & Operation Guide (Supplied with the scanner/Electronic Manual)
Describes the procedure for setting up the CR-L1 for scanning. Set up the CR-
L1 in accordance with the Setup & Operation Guide. For details on the CR-L1, 
refer to the User Manual (electronic manual).

User Manual (Electronic Manual): This Manual
Describes how to use the scanner, and includes instructions for configuring the 
scanner settings, as well as handling, maintenance, and troubleshooting 
information.

Symbols Used in This Manual
The following symbols are used in this manual to explain procedures, 
restrictions, handling precautions, and instructions that should be observed for 
safety.

WARNING
Indicates a warning concerning operations that may lead to death or injury to 
persons if not performed correctly. To use the machine safely, always pay 
attention to these warnings.

CAUTION
Indicates a caution concerning operations that may lead to injury to persons, or 
damage to property if not performed correctly. To use the machine safely, 
always pay attention to these cautions.

IMPORTANT
Indicates operational requirements and restrictions. Be sure to read these items 
carefully to operate the machine correctly, and avoid damaging the machine.

NOTE
Indicates a clarification of an operation, or contains additional explanations for 
a procedure. Reading these notes is highly recommended.
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Important Safety Instructions

Handling

WARNING
■ Never install and operate the scanner near flammable substances, such as 

alcohol, paint thinner, benzene, or any other type of volatile solution.
■ Never damage or modify the power cord, and never place heavy objects on 

the power cord.
■ Always make sure that your hands are dry when you are handling the power 

cord or power plug. Never grasp the power plug when your hands are wet.
■ Never plug the scanner into a multiplug power strip.
■ Never bundle, wrap, or tie the power cord around itself or another object. 

Connect the power plug securely into the power outlet.
■ Use only the power cord and power plug provided with the scanner.
■ Never attempt to disassemble or modify the scanner.
■ Never use flammable aerosol products near the scanner.
■ Before you clean the scanner, turn the power OFF and disconnect the power 

cord from the power outlet.
■ To clean the scanner’s exterior, use a firmly wrung cloth, moistened slightly 

with water or mild detergent. Never use any type of volatile solution, such as 
alcohol, benzene or paint thinner.

■ If you hear strange sounds, detect smoke or abnormal heat, sense vibration, 
or smell odd odors around the scanner, turn OFF the power switch 
immediately and disconnect the power cord from the power outlet. Contact 
your local authorized Canon dealer or service representative to have the 
scanner serviced.

■ Handle the scanner with care. Avoid shock and vibration to the scanner 
caused by reckless handling. If you suspect the scanner has been 
accidentally damaged, turn OFF the power switch immediately and 
disconnect the power cord from the power outlet. Contact your local 
authorized Canon dealer or service representative to have the scanner 
serviced.

■ Before you move the scanner, always turn OFF the power and disconnect 
the power cord from the power outlet.

■ This product emits low level magnetic flux. If you use a cardiac pacemaker 
and feel abnormalities, please be away from this product and consult your 
doctor.

CAUTION
■ To avoid damage to the scanner, never place the scanner on an unstable or 

vibrating surface. The scanner may tip or fall over, causing injury.
■ Keep all liquids, beverages, or any type of liquid, and clips, staples, 

necklaces, or other metal objects away from the scanner. If you accidentally 
spill liquid or drop a metal object into the scanner, turn OFF the power 
immediately and disconnect the power cord from the power outlet. Contact 
your local authorized Canon dealer or service representative to have the 
scanner serviced.

■ Never install the scanner in humid or dusty locations. Doing so may cause a 
fire or electrical shock.

■ Never place heavy objects on top of the scanner, as these objects may tip 
or fall over, and cause injury.

■ When you remove the power cord, grip it by the power plug head. Never 
attempt to disconnect the power cord from the power outlet by pulling on the 
power cord. Doing so may damage or expose the cord’s internal wiring, and 
cause a fire or electrical shock.

■ Keep the area around the power outlet clear of all obstacles so you can 
disconnect the power cord easily at all times.

■ Never spill water or volatile solutions (alcohol, benzene, paint thinner) into 
the scanner. Doing so may cause a fire or electrical shock.

■ When the scanner is not being used for a long period of time, disconnect the 
power cord from the power outlet.

■ Avoid wearing loose fitting clothing, dangling jewelry, long ties, or long hair 
that could become entangled with moving parts, especially the rollers that 
feed paper into the scanner. If such objects become entangled, immediately 
disconnect the power plug from the power outlet to stop the scanner.

■ Be careful when you are loading a document or clearing a paper jam. It is 
possible that the paper edges may cut your fingers.

■ Do not open the Maintenance Cover while the scanner is operating. Doing 
so may result in a malfunction or injury.

■ Do not touch the pins and contacts on the scanner’s connector with your 
hands. Doing so may result in a malfunction.

Disposal
When disposing of this scanner, be sure to follow all local ordinances and laws 
or consult with the retailer who sold you the scanner.
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Installation Location
For operation, maintenance, and ventilation, make sure that there is enough 
space around the scanner.

Avoid placing the scanner in the following places. It may cause a malfunction 
and adversely affect the scanner or your computer.
• Places exposed to direct sunlight

If installation in such places is unavoidable, provide a curtain or similar object 
to shade the scanner.

• Places subject to dust and fumes
Dust and cigarette fumes adversely affect the components inside the 
scanner.

• Near running water, a heat source, water vapor, or in an area, such as a 
laboratory exposed to ammonia gas, paint thinner, or other volatile chemicals

• Places subject to excessive vibration and shock
• Places subject to rapid changes in temperature or humidity

Condensation occurring inside the scanner may impair image quality. Place 
the scanner in a room that is within the following range:
Room temperature: 10°C to 32.5°C (50°F to 90.5°F)
Relative humidity: 20% to 80% RH

20% to 50% RH when using the imprinter
Use the recommended operating environment for the ink cartridge when 
using the imprinter.

• Near electronic equipment or heavy equipment that generates a strong 
magnetic field, such as a speaker, TV, and radio

Power Supply
• Connect only to a power outlet of the rated voltage and power supply 

frequency (either 120V, 60 Hz or 220-240V, 50/60 Hz, depending on your 
region).

• Make sure that the scanner is connected to an independent power outlet. Do 
not plug the scanner into an outlet shared with another device. If you use an 
extension cord, make sure that the extension cord is rated for the current 
requirements of the scanner.

• If you are unsure of anything relating to the power supply, contact your local 
authorized Canon dealer or service representative for further information.

• Never place an object on top of the power cord or step on the power cord.
• Never bundle the power cord or wrap the cord around an object, such as a 

table leg.
• Do not tug on the power cord. When you remove the power cord, grip it by 

the power plug head.
• Keep the area around the power outlet free of obstacles.
• Connect only to a power outlet of the rated voltage and power supply 

frequency (either 120V, 60 Hz or 220-240V, 50/60 Hz, depending on your 
region).

• Do not connect to power outlets with other electrical devices. Also, when 
using an extension cord, make sure that the extension cord is rated for the 
current requirements of the scanner.

• Disassembling and/or reassembling the AC adapter is extremely dangerous 
and should not be attempted under any circumstances.

• Do not place heavy objects on the AC adapter or power cord. Do not place 
the adapter or cords in an area where they are likely to be stepped on.

• Do not use the power cord while it is bundled.
• Never pull directly on the power cord. To remove the plug from the outlet, 

grasp the plug directly and remove it from the outlet.
• Keep the area around the power plug clear of articles so that the power plug 

can be disconnected in an emergency.
• Use only the AC adapter provided with the product. Do not use the scanner’s 

AC adapter with any other product.
• If you have any questions about the AC adapter, contact your local authorized 

Canon dealer or service representative for further information.

Moving the Scanner
When you move the CR-L1, hold it firmly with both hands and carry it carefully. 
Do not hold the scanner by the Eject Stopper. The scanner weighs 
approximately 2.1 kg (4.6 lb).

WARNING
When moving the scanner, be sure to turn OFF the power and remove any 
cables. If the cables are not removed before moving the scanner, you may 
damage the plugs or connector by forcibly pulling them out.
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Introduction to the CR-L1

This chapter describes the features of the CR-L1 scanner, what comes 
packaged in the box, and the names and functions of parts on the scanner.

The Canon Check Reader CR-L1 is a scanner with magnetic heads that can 
read checks and other documents that are printed with MICR (Magnetic Ink 
Character Recognition) compatible fonts, and is capable of OCR (Optical 
Character Recognition).

Features

Fast and Smooth Scanning
The CR-L1 performs high-speed scans of check-size documents at 45 cpm 
(200 dpi resolution).

Supports Long Documents
Documents up to 108 mm x 2,000 mm (4.3" x 78.7") can be scanned.

Compact Size
140 mm (W) x 223 mm (D) x 188 mm (H) (5.5" (W) x 8.8" (D) x 7.4" (H))

Supports Color, Black-and-White (Binary) and Grayscale Output

Reads MICR Characters
A magnetic head is used to scan MICR characters that have been printed with 
magnetic ink or toner.

Supports OCR (Optical Character Recognition)
Character images, such as E13B, OCR-A, OCR-B, and check writer are 
recognized as characters by the OCR function.

Supports UV scanning (UV model only)
CR-L1 UV can scan images that are printed with UV fluorescent ink.
This function only scans the front side of documents.

Easy to Maintain
Maintenance Covers make handling paper jams and cleaning easy.

Paper Thickness Adjustment Mechanism
Adjust the Separation Roller gap to the thickness of the paper being fed.

Infrared Double Feed Detection
The scanner detects double-fed documents using infrared sensor.

Imprinter Is Standard Equipment
An imprinter mechanism, which prints text on documents as they are scanned, 
comes standard equipped with the scanner. The imprinter’s ink cartridge is not 
included, and must be purchased separately. (See “About the Ink Cartridge,” 
on p. 16.)

Features of the CR-L1
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This section describes the names and functions of each part. Before you connect the CR-L1, familiarize yourself with its parts and their functions.

Front View

Part Names

Document Eject Opening

Paper Thickness Adjustment Dial
Adjust the gap between the separation roller and 
feeding roller to the thickness of the paper being fed. 
(See “Adjusting the Separation Roller Gap,” on 
p. 40.)

Imprinter Cover

Maintenance Cover
Open this cover to clear paper jams or
clean the scanner.

Document Feed Opening

Power Indicator
Lights blue when the power is turned ON. 
(See “Turning ON and OFF the Power,” on p. 7.)

Eject Stopper
Adjust to match the length of the document. 
(See “Placing Documents,” on p. 23.)

Document Feed Tray
Pull out to load documents. 
(See “Placing Documents,” on p. 23.)
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Print Position 
Adjustment Lever
Adjusts the print 
position. 
(See “Setting the Ink 
Cartridge and 
Adjusting the Print 
Position,” on p. 16.)

Feeding Roller
Feeds the document.

Ink Cartridge
The ink cartridge is not included, and must 
be purchased separately. 
(See “About the Ink Cartridge,” on p. 16.)

Lock Lever
Locks the ink cartridge in place.

Magnetic Head for 
MICR
Reads MICR text 
printed in magnetic 
ink. (See “Cleaning the 
Magnetic Heads,” on 
p. 34.)

Separation Roller
Separates a stack of documents into single sheet one by one. 
(See “Adjusting the Separation Roller Gap,” on p. 40.)

Feeding Roller
Feeds the document.

Ink Absorber
Absorbs any ink that 
leaks out of the ink 
cartridge.
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Rear View

Connectors/Power Switch

Units: millimeters (units in parenthesis are inches)

Reading Unit 
(Access Hatch)
Open to clear paper jams or clean the 
scanner. 
(See “Clearing Paper Jams,” on 
p. 28.)

Connectors/
Power Switch

Power Switch
Slide to turn the 
scanner power ON. 
Slide again to turn the 
scanner power OFF. 
(See “Turning ON 
and OFF the Power,” 
on p. 7.)

Power 
Connector
Connect the included AC 
adapter plug. 
(See “Connecting the 
Power Cord,” on p. 6.)

USB Connector
Connect a Hi-Speed USB 2.0 
compliant USB cable. (See 
“USB Connections,” on p. 6.)

Exterior Dimensions

140 mm (5.5")

144 mm (5.7") 223 mm (8.8")

18
8 

m
m

 (
7.

4"
)
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This section describes how to prepare the ink cartridge so that you can use the 
imprinter to print text on scanned documents.

About the Ink Cartridge
The ink cartridge is not included with the scanner. Purchase an ink cartridge 
separately, as shown below.
Manufacturer : Hewlett Packard
Ink Cartridge Blue : C6602B  (Canon#3693A002)
Ink Cartridge Red : C6602R  (Canon#3693A003)
Ink Cartridge Green: C6602G  (Canon#3693A004)

Setting the Ink Cartridge and Adjusting the 
Print Position
The ink cartridge needs to be set to print. Set the ink cartridge according to the 
following procedure. You can adjust the print position to three different levels.

IMPORTANT
• To set the ink cartridge, turn the scanner OFF before removing the Maintenance 

Cover. After the ink cartridge is set, replace the Maintenance Cover, and then turn 
the scanner back ON.

• Finish up the unpacked ink cartridge as soon as possible. More frequent cleaning 
of the ink cartridge is required if long time elapses after unpacking.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B Remove the Imprinter Cover.

C Remove the ink cartridge from its bag.

IMPORTANT
Do not touch the ink cartridge contacts. This can cause a bad electrical contact and 
reduced print quality.

Preparing the Ink Cartridge

Tag

Ink Jet Nozzle

Contacts
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D Grasp the tag and then peel off the tape covering the ink jet nozzle.

IMPORTANT
Do not touch the ink jet nozzle or contacts after peeling off the tag and tape.

E Place the ink cartridge shown in the diagram below.

CAUTION
Do not touch the electrical contact on the carriage. Doing so may cause a 
malfunction.

NOTE
Do not use more than one cartridge by rotation. If you do so, applications cannot 
check the ink level precisely.

F Push down the ink cartridge until it clicks into place.

IMPORTANT
Make sure that the ink cartridge lock lever locks the ink cartridge into the correct 
position.

Ink Cartridge Lock Lever

If the cartridge does not 
load properly, see step 7.
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G Squeeze the Print Position Adjustment Lever and move it to adjust the 
print position.

If the ink head drops back when installed, the two ink cartridge pins will not fit 
into the holes on the carriage. Push back the ink cartridge lock lever A in the 
direction of the arrow and reset the cartridge in the correct position B.

H Carefully replace the Imprinter Cover.

I Gently close the Maintenance Cover until it clicks into place.

Top:
50.5 mm (1.99") from the bottom edge of 
the document

Middle:
47 mm (1.85") from the bottom edge of 
the document

Bottom:
43.5 mm (1.71") from the bottom edge of 
the document

Ink Cartridge 
Holes

Ink Cartridge 
Pins
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Software

This chapter describes how to use the Scanning Utility.

This section describes how to start up the Scanning Utility so that you can use 
the scanner. Read the Help files for the Scanning Utility for information on how 
to use it.

How to Use the Scanning Utility
This section describes the procedure for using the Scanning Utility. Read the 
[Help] file in [Scanning Utility] for more information.

A Click [Start], and then click [All Programs].

B Click [Scanning Utility for CR-50&80&L1].

C Start the Scanning Utility.

NOTE
The basic operation of the Scanning Utility is noted in the Scanning Utility help file. On 
the [Help] menu, click [Help] to view the explanation.

D Select [Scanner Setting] from the [File] menu.

The Settings dialog box appears.

How to Use the Software
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E Set the scan conditions and click [OK].

NOTE
For information about the settings for the scan conditions, click [Help] on the Settings 
dialog box to open the Help file.

F Select the scanning method from the [File] menu and start scanning.

G When scanning is finished, click [Exit] on the [File] menu to quit the 
Scanning Utility.

This section describes how to uninstall the Scanning Utility.

IMPORTANT
• Be sure to log on as the Administrator.
• The procedure in Windows 8.1/10 is different from the ones described in this 

manual. Refer to the Windows 8.1/10 “Help and Support Center” to uninstall the 
software.

A Click [Start], and then click [Control Panel].

Uninstalling the Software
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B Click [Programs], and then click [Programs and Features].

NOTE
Depending on the status of your computer, the following screen may be displayed. In 
that case, double-click the [Programs and Features] icon.

C Select the software that you want to remove from the list in the dialog 
box, and then click [Uninstall].

NOTE
When the [User Account Control] dialog box appears, click [Continue].

IMPORTANT
If you uninstall “Scanning Utility for CR-50/80/L1 (or CR-50&80&L1)” you also need to 
uninstall “Canon Driver for CR-50/ 80/ L1 (or CR-50&80&L1).”

D The [Confirm File Deletion] dialog box appears.

If you selected “Canon Driver for CR-50/ 80/ L1 (or CR-50&80&L1)”, the 
above dialog box appears.

E Click [Yes], and the uninstaller starts.
Follow the instructions on the screen to finish uninstalling the software.
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Document Feeding and Scanning

This chapter describes precautions regarding documents that can be handled 
on this scanner and scanning operations.

This section describes the types of documents that can be used and how to 
place them.

CAUTION
Treat the documents carefully. The paper edges may cut your fingers.

Document
The CR-L1 can feed a wide variety of document sizes. The ranges of height and 
length for a document are:

Height : 50 to 108 mm (2.0" to 4.3")
Length : 95 to 228 mm (3.7" to 9.0")

up to 2,000 mm (78.7") with Long Document mode
Thickness : 0.08 to 0.20 mm (0.003" to 0.008")
Weight : 64 to 157 g/m2 (17 to 40 lb bond)

81 to 105 g/m2 (21.5 to 26.8 lb bond) with Double Feed Detection 
enabled

NOTE
Depending on the paper type and paper thickness, false detection of double 
feed may occur.
Follow these guidelines when you prepare a document for scanning:
• Before scanning documents that contain pasted artwork, make sure that the 

ink or paste is thoroughly dry. If the documents are scanned with wet ink or 
paste, the inside of the scanner may become dirty and it may cause a 
malfunction.

• If you scan a document written in pencil, the letters may not be scanned 
properly or the pencil may rub off onto the rollers and stain subsequent 
documents. Before you scan this kind of document, make a copy, and then 
scan the copy. After scanning a document written in pencil or some other soft 
writing material, be sure to clean the scanning rollers. (See “Cleaning the 
Scanning Glass and Rollers,” on p. 32.)

• If you scan thin paper in the Duplex mode, the ink printed on the back side 
may be scanned. If this happens, adjust the scanning density.

• Scanning documents with a rough surface may not feed easily, and may 
cause friction between the documents, resulting in a feeding error. If this 
happens, feed the documents one by one.

• To avoid paper jams, damage to documents, and a scanner malfunction, do 
not feed the following types of paper into the scanner. If you want to scan 
these types of paper, first make a copy, and then scan the copy.

NOTE
• Note that mixing documents of different thickness may cause a malfunction during 

feeding.
• Curled, wrinkled, or folded documents may cause an error. If this happens, 

straighten out the curls, or reduce the number of documents loaded.

Documents

Length

Height

Wrinkled or creased 
paper

Carbon backed 
paper

Curled paper

Torn paper

Paper with clips or 
staples

Coated paper or fax 
recording paper

Extremely thin paper

Paper with binding 
holes
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Using Infrared Double Feed Detection
The double feed detection function that the scanner is equipped with uses the 
infrared sensor to detect when two or more documents are fed at the same time.
If false detections happen too often, disable the double feed detection function.

NOTE
• When Using the Accompanying Scanning Utility for CR-50/80/L1 (or CR-

50&80&L1):
You can disable the double feed detection function from [Scanner Setting] in the 
Scanning Utility.

• For more details about how to configure scanning parameters, click the [Help] 
button in the settings dialog box to view the Canon driver help.

IMPORTANT
• The following types of document may be misdetected as double fed:

• Documents with a colored background
• Documents with a glossy finish 

If misdetection of double feeds occurs often, turn off double feed detection.

Placing Documents
Note the following points when placing documents on the scanner.
• Place the front of the document toward you.
• A maximum of 50 documents (90g/m2 (24 lb bond)) or a document stack 

no higher than 5 mm (0.2") can be loaded at one time (including curling).
• Move the stopper to the edge of the document in the document tray in 

accordance with the document. Otherwise, this may cause a paper eject 
error.

• When scanning multiple documents, sort them into batches of uniform 
paper quality and thickness and load each batch separately. Note that 
loading mixed batches may cause paper jams.

• When scanning relatively thick (0.15 mm to 0.2 mm (0.005" to 0.008") 
documents, the feeding process may cause the document to curl and 
cause paper jams at the document feed opening. For such documents, 
load no more than 10 sheets at one time.

IMPORTANT
Align the documents and set the bottom of the documents level in the document tray.

This section describes how to load and scan documents.

CAUTION
• Avoid wearing loose fitting clothing, dangling jewelry, long ties, or long 

hair that could become entangled with moving parts, especially the 
rollers that feed paper through the scanner. If such objects become 
entangled, immediately disconnect the power plug from the power 
outlet.

• Check the paper stack and remove all clips, staples, pins, or any other 
type of metal or plastic fastener. These objects may cause damage to the 
document, a paper jam, or a scanner malfunction.

• Do not touch documents that are being fed under any circumstances. 
The documents that are being fed may cut your hand.

Scan Procedure
A Pull out the document feed tray.

B Carefully align the edges of the document.

C Load the documents with their front sides facing right and with their 
edges flush against the document load mark.

Document Feeding and Scanning

Document 
Load Mark
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D Adjust the Eject Stopper in accordance with the document.

E Instruct scanning to start from the software application.

NOTE
• When Using the Accompanying Scanning Utility for CR-50/80/L1 (or CR-

50&80&L1): 
There are three scanning methods as follows. Follow the each instruction.
Scan 1 page 
Click [Scan Page] from the [File] menu.

Scan Batch to File
A Click [Scan Batch to File] from the [File] menu.
B Input the File name, and then click [Save].
C Select Simplex or Duplex, and then click [Start Scanning].

Scan Batch to Printer
A Click [Scan Batch to Printer] from the [File] menu.
B Select Simplex or Duplex, and then click [Start Scanning].

F Scanning starts.

NOTE
When printing with the imprinter, ink may get on the leading edge of the document 
because the documents are ejected onto the printed surface.

Confirming Proper Document Feeding
Depending on the thickness of documents scanned with the CR-L1 and the 
paper thickness setting, double feeds or feeding errors may occur.
After installing the CR-L1 or before scanning documents of a different 
thickness, perform the procedure below to confirm that documents are 
separated one sheet at a time. If documents do not feed properly, see 
“Adjusting the Separation Roller Gap,” on p. 40 to adjust for paper thickness.

A Start the Scanning Utility.

NOTE
For instructions on using the scanning utility, see “How to Use the Scanning Utility,” 
on p. 19. You can also refer to the scanning utility help in the [Help] menu.

B Pull out the document feed tray.

Ink residue Printed text (back side)
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C Load two documents with their edges flush against the mark.

D Adjust the position of the eject stopper. (If necessary, see the diagram 
in step 4 on p. 24.)

E Click [Scan Page] from the [File] menu and confirm that only one 
sheet is fed.

NOTE
If the sheets do not feed properly (they double-feed or no sheets are fed), see 
“Adjusting the Separation Roller Gap,” on p. 40 to adjust for paper thickness.

F Exit the scanning utility.

Long Document Mode
You can scan documents up to 2,000 mm (78.7") in length with the Long 
Document mode. 

CAUTION
Be careful not to cut your finger with the edge of the document.

IMPORTANT
Note the following points when using the Long Document mode.
• Detach the Eject Stopper when feeding long documents.
• When feeding long documents, if a document is loaded into the scanner askew, it 

may catch on the edge of the feeder and suffer damage. Make sure to take extra 
care that documents are loaded straight in this mode.

• In the Long Document mode, documents may suffer damage because paper jam 
detection is delayed. Make sure to take extra care against paper jams in this mode.

• Processing speed may decrease when scanning with the Long Document mode.

A Start the Scanning Utility. (“How to Use the Scanning Utility” on p. 19.)

B Click [Scanner Setting] from the [File] menu.
The scanner driver's Detail Settings screen will open.

IMPORTANT
When the scanner settings screen is opened by the application, the below screen is 
displayed, in which advanced scanning conditions can be specified.

NOTE
For details on the setting screen, see the Help of the scanner driver.
Click the [Help] button of the driver to display help related to the corresponding tab 
or dialog box.

Document 
Load Mark
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C Set the [Page Size] in the [Basic] tab to [Auto detection] when 
scanning in the Long Document mode.

D Then, set the [Long Document mode] value in the [Others] tab.
You can scan documents up to 2,000 mm (78.7") long by setting the 
scanner to the Long Document mode. Select [Standard] or [2000mm] 
depending on the length of the document.

E Click [OK] to close the scanner driver settings screen.

F Pull out the document feed tray.

G Pull out the Eject Stopper.

H Pinch the Eject Stopper and slide it to detach.

I Load the document.

CAUTION
• When scanning long documents whose length are more than 228 mm (9.0"), place 

one document at a time. Otherwise, it may damage the documents.
• When feeding the document, support it to keep the same height between the 

document and the feed path. If the document is lower than the feed path, the 
document may be torn. If the document is higher than the feed path, the scanned 
image may be skewed.

• The lower edge of a thin long document may be damaged with feeding. Do not feed 
the document fed many times or torn documents.

horizontal
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J Instruct scanning to start from the software application.

IMPORTANT
• Set the [Page Size] to [Auto detection] when scanning in the Long Document mode.

• The document length that can be scanned in the Long Document mode depends 
on the scan mode and resolution.

K Scanning starts.

L When scanning is finished, push the Eject Stopper into the document 
feed tray to attach.

Auto Power Off
The scanner automatically turns off when scanning or another operation is not 
performed for a certain time.
To setting this function, follow the procedure below.

A Start Windows and log in as a user with administrator privileges.

B Click the Start button, and then click [All Programs], [CANON CR-L1], 
and [Canon imageFORMULA Utility].
imageFORMULA Utility starts.

C Click [CANON CR-L1 USB] and click [Properties].
Scanner properties are displayed.

D Click the [Maintenance] tab and then click [Turn off automatically after 
4 hours] check box to change the setting.

E Click [OK] to close the scanner properties.

Mode DPI Maximum Length

Black and White
Error Diffusion

Fine Text Filtering
16-level Gray
256-level Gray

100

2,000 mm (78.7")

120

200

300

24-bit Color

100

120

200

24-bit Color 300 1,000 mm (39.4")
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Troubleshooting

This chapter describes the problems that might occur in the CR-L1, and how to 
remedy them.

The following causes and remedies describe why your computer may not 
recognize the scanner.

If paper has jammed, open the Maintenance Cover and remove the jammed 
paper.

IMPORTANT
Do not attempt to pull the jammed paper upwards or backwards against the feeding 
direction. Doing so can damage the internal parts of the scanner.

CAUTION
• Be careful when you clear a paper jam. You may be injured unexpectedly. For 

example, the paper edges may cut your fingers, or the document may be 
damaged.

• Remove all jammed sheets of paper. Paper scraps left inside the scanner may 
cause a paper jam or malfunction.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B While lowering the down the OPEN lever, open the reading unit.

When the Scanner Is Not Recognized

Cause The Scanning Utility is not installed.

Remedy Install the Scanning Utility before connecting the scanner to the 
computer. (See “Setting Up the Scanner,” on p. 4.)

Cause The scanner is not correctly connected to the computer.

Remedy Connect the scanner to the computer correctly. (See “Connecting 
the Scanner to a Computer,” on p. 6.)

Cause The USB interface provided as standard with your computer is 
not compatible with the scanner.

Remedy Not all USB interfaces provided as standard with personal 
computers are guaranteed. Contact your local authorized Canon 
dealer for more detailed information. (See “Checking Your 
Operating Environment,” on p. 5.)

Cause USB cable is not compatible with the scanner.

Remedy Use the USB cable provided with the scanner. (See “Checking Your 
Operating Environment,” on p. 5.)

Cause USB hub is not compatible with the scanner.

Remedy Remove the USB hub to use the scanner. (See “Checking Your 
Operating Environment,” on p. 5.)

Clearing Paper Jams
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C Remove the paper that has jammed.
If the paper is jammed at the pickup area: Pull the paper forward and clear 
the jam from the Maintenance Cover.

If the paper is jammed at any other area: Pull the paper forward and clear 
the jam from the nearest opening.

D Gently close the reading unit until it clicks into place.

E Gently close the Maintenance Cover until it clicks into place.
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Check the following conditions, and take the appropriate action.

The power indicator is not lit.
Slide the Power Switch to the right. (See “Turning ON the Power,” on p. 7.)

The power cord is not connected into a power outlet.
Connect the power cord into a power outlet. (See “Connecting the Power 
Cord,” on p. 6.)

If the document is not fed properly or the detection functions do not work 
properly, remedy the problem by checking the following conditions.

The Scanner Does Not Turn ON Feeding Trouble

Condition A paper jam has occurred.

Cause and 
Remedy

• Check to make sure that the size and thickness of the 
document are within the supported range of the scanner, and 
if the quality of the paper is appropriate.
For cautions on handling documents, see “Documents,” on 
p. 22.

• Documents with rough surfaces may cause a paper feed error 
to occur.

• Dirty or worn rollers inside the scanner may cause a paper 
jam.
Clean the rollers if they are dirty. (See “Cleaning the Scanning 
Glass and Rollers,” on p. 32.) Worn rollers must be replaced. 
Contact your local authorized Canon dealer or service 
representative to have the scanner serviced.

• The Separation Roller gap is too wide. Adjust the Separation 
Roller gap. (See “Adjusting the Separation Roller Gap,” on 
p. 40.)

Condition A double feed error often occurs.

Cause and 
Remedy

A double feed error may occur when documents with different 
thicknesses are mixed.
If the above-mentioned method is not effective or you are using 
the CR-L1 scanner, adjust the Separation Roller gap. (See 
“Adjusting the Separation Roller Gap,” on p. 40.)

Condition MICR characters are not recognized correctly.

Cause and 
Remedy

• The scanner cannot correctly read MICR characters if the 
magnetic heads are dirty. Clean the MICR magnetic heads. 
(See “Cleaning the Magnetic Heads,” on p. 34.)

• If MICR characters cannot be recognized correctly after 
cleaning the heads, the MICR heads may be worn. Contact 
your local authorized Canon dealer or service representative 
to have the scanner serviced.

• The MICR text is on the back of the document. Load the side with 
the MICR characters face up in the document tray.

Other 
Causes

• Some of the MICR characters are scratched or missing. 
Splattered MICR ink or toner may also be the problem.

Condition The imprinter is not printing correctly (missing imprint 
dots).

Cause and 
Remedy

Ink is clogged in the ink jet nozzle. Clean the ink jet nozzle. 
Cleaning the ink jet nozzle is recommended before using the 
CR-L1. (See “Cleaning the Ink Jet Nozzles,” on p. 34.)



31

If there is a problem with the scanned image (the image is not sharp or stripes 
appear), one of the following conditions may be a probable cause. Check the 
following conditions, and take the appropriate action.

The scanning glass or rollers are dirty.
If the scanning glass or rollers are dirty, the dirt will appear on the scanned 
image.

Clean the scanning glass and rollers. For details, see “Cleaning the 
Scanning Glass and Rollers,” on p. 32.

The scan conditions are inappropriate.
If the scan conditions are inappropriate, the scanned image will not be sharp 
or will appear as dark.

Check the brightness and other scanner settings.
If the scanned image is blurry or the document has not been scanned at all, 
the brightness may be set too high.
If the scanned image appears dark, the brightness may be set too low. 
Also, check the settings on the driver and the software application.

Check the basic Scanning Conditions. (UV models only)
If other than [16-level Gray] or [256-level Gray] is selected for Mode menu in 
the scanner driver, the scanned image may not be appropriate.
Also, check the settings on the driver and the software application.

The driver or application does not run correctly.
If the document cannot be scanned correctly even if the scan conditions are 
adjusted, the driver or the application may not be functioning correctly.

Reinstall the driver or application. 
For details on how to install the driver, see “Installing the Software,” on p. 5. 
For details on how to install the application, see the applications instruction 
manual.

Other Causes
Even if the computer may be recognizing the scanner correctly, and the 
driver and the application is installed correctly, scanning may not be 
performed correctly. If this happens, the interface card is not compatible. 
Use the recommended interface card.

If the above remedies do not rectify the problem, contact your local authorized 
Canon dealer or service representative to have the scanner serviced.

Other 
Causes

The ink cartridge may be empty.

Condition Documents get dirty when using the imprinter.

Cause and 
Remedy

Ink from the imprinter has been placed on the feed path. Clean the 
ink off the feed path. (See “Cleaning the Ink Jet Nozzles,” on 
p. 34 and “Cleaning the Inside of the Scanner” on p. 32.)

When the Scanned Image Is Not Normal
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Maintenance

This chapter describes how to clean and maintain the scanner.

To ensure high-quality image scanning, regularly clean your CR-L1 as 
described below.

CAUTION
• Before you clean the scanner, turn OFF the scanner and computer, and 

disconnect the power cord from the power outlet. Otherwise, it may cause an 
electrical shock.

• Never clean the scanner with any kind of organic solvent, such as alcohol, 
benzene, or paint thinner. This may cause a fire and electrical shock, or cause 
the exterior of the scanner to disfigure or discolor.

• Never spray mild detergent or water directly on the scanning glass. The spray 
could penetrate below the glass and contaminate the internal light source and 
lenses.

Cleaning the Main Unit
Wipe the scanner with a firmly wrung cloth, moistened slightly with water or mild 
detergent. Then, wipe off with a clean, dry cloth.

Cleaning the Inside of the Scanner
Dust or paper particles inside the scanner can cause lines in scanned images. 
Use compressed air for regular cleaning of dust and paper particles from inside 
the scanner. After finishing a large scanning job, you should turn OFF the 
scanner and then clean off any paper particles that are remaining.

Cleaning the Scanning Glass and Rollers
If stripes appear on scanned images or if dirt appears on scanned documents, 
clean the scanning glass and rollers. Clean the scanning glass and rollers 
regularly.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B While lowering the open lever, open the reading unit.

WARNING
Do not use flammable liquids to clean the scanner, including alcohol, benzene, 
or paint thinner.

Daily Cleaning
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C Spin the rollers while wiping them clean with a firmly wrung cloth 
dampened with water or a mild detergent.
There are 18 roller positions, as shown in the diagram below.

NOTE
• Use cotton swabs to clean the rollers in locations that are too narrow for your 

fingers, such as A, B, J, N, O, and P.
• Rollers in positions B, D, E, K, and P are turned by the roller in position E. Turn 

the roller in position E to wipe the rollers.
• Rollers in positions M and N comprise two rollers each, an upper roller and a lower 

roller.
• Do not force the rollers if they will not turn. In this case, wipe dirt only off of the 

exposed area.

D Use cotton swabs to clean the entire scanning glass. There are two 
scanning glass areas, one on each side. Use a cotton swab to wipe 
dirt from the entire surface of each.

IMPORTANT
Scratches on the scanning glass may cause marks on the images and could cause 
feeding errors. If there are scratches on the scanning glass, contact your local 
authorized Canon dealer or service representative.

E Gently close the reading unit until it clicks into place.

F Gently close the maintenance cover until it clicks into place.

Scanning 
Glass
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Cleaning the Magnetic Heads
If the magnetic heads are dirty, then MICR characters cannot be scanned 
correctly. Periodically, clean the magnetic heads with a commercially available 
audio head cleaner.

A Hook your finger around the open lever and open the maintenance 
cover.

B Use a commercially available audio head cleaner to clean the 
magnetic heads.
The magnetic head is located in the position shown in the diagram below.

C Gently close the maintenance cover until it clicks into place.

Cleaning the Ink Jet Nozzles
Ink that collects around the ink jet nozzles may stain your documents or cause 
the text to appear as scratched. Clean the area around the ink jet nozzles 
periodically. Cleaning the ink jet nozzles is also efficient action when the printed 
text becomes faint.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B Dampen a cloth with water, wring the cloth out thoroughly, and then 
wipe off the dirt around the ink absorber.

IMPORTANT
If your documents are stained and smudged from printing even after you clean the 
ink absorber, you should replace the ink absorber. Contact your local authorized 
Canon dealer or service representative.

C Remove the ink cartridge.
For more information, (See “Replacing the Ink Cartridge,” on p. 37.)

Magnetic Head

Ink Absorber
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D Use a dry cotton swab to wipe off any ink on the ink jet nozzle.
If the text still appear faint after this operation, replace the ink cartridge 
(See “Replacing the Ink Cartridge,” on p. 37.)

E Set the ink cartridge.
For more information, see “Setting the Ink Cartridge and Adjusting the 
Print Position,” on p. 16.

F Carefully replace the Imprinter Cover.

G Gently close the Maintenance Cover until it clicks into place.

Cleaning with the Cleaning Cards (United 
States Only)
If a black stripe appears on the back-side of scanned images or if dirt
appears on the paper documents upon scanning or for preventative
measures, we recommend that you clean your Canon CR-Series
scanner as needed with a cleaning card. Using a cleaning card will
minimize the frequent cleaning as instructed in this manual.
It is best to perform a cleaning at beginning or end of the day. A cleaning card
does not clean the ink jet nozzles, so please remove the ink cartridge and
perform a nozzle cleaning (See “Cleaning the Ink Jet Nozzles,” on p. 34)

IMPORTANT
• This operation is for the Cleaning cards that are available only in the United 

States.
• Contact your local authorized Canon dealer or service representative for the 

available cleaning card.

A You may download the Canon Check Scanner Cleaning Tool from the 
Canon U.S.A. website at the following URL:
http://www.usa.canon.com/checktransports

B Pull the Eject Stopper.

C Place the cleaning card (for Check Path Cleaning) in the document 
tray.
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D Locate where you saved the file From step1 , extract it and double-
click the CleanCR.exe file shown below.

E From the drop-down menu, please select CR-50/ 80/ L1 and click 
[OK].

F With the Cleaning Card already in the feed pocket of the scanner, 
please click Clean.

G The Cleaning Card will then proceed through the paper path as 
shown below.

H Please repeat steps 3 and 6. 
A typical cleaning consists of feeding the Cleaning Card 3-7 times. Each 
time you run the card through, invert and/or flip it in the feed pocket. If the 
scanner is extremely dirty, you may need to use another Cleaning Card.
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I When you have finished cleaning your scanner, please click on the 
Close button to exit out of the Canon Check Scanner Cleaning Tool.

NOTE
Upon completion, please allow 1 to 2 minutes for the moisture on the Canon CR-
Series scanner from the Cleaning Card to thoroughly dry before scanning 
documents.

Make the following adjustments to maintain scanning quality.

Replacing the Ink Cartridge
The ink cartridge needs to be replaced if the printed text becomes scratchy or 
faint even if you have cleaned the ink jet nozzle. Replace the ink cartridge 
according to the following procedure below.

IMPORTANT
• To replace the ink cartridge, turn the scanner OFF before removing the 

Maintenance Cover. After the ink cartridge is set, replace the Maintenance 
Cover, and then turn the scanner back ON.

• Finish up the unpacked ink cartridge as soon as possible. More frequent cleaning of 
the ink cartridge is required if long time elapses after unpacking.

NOTE
• Use an ink cartridge. (See “About the Ink Cartridge,” on p. 16.)
• Do not use more than one cartridge by rotation. If you do so, applications cannot 

check the ink level precisely.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B Remove the Imprinter Cover.

Maintenance
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C Squeeze in both sides of the print position adjustment lever and move 
the print cartridge carriage to its lowest position.

D Push back the ink cartridge lock lever in the direction of the arrow in 
the diagram below, and pull out the ink cartridge by grasping the tab 
as shown in the diagram.

CAUTION
Do not touch the ink jet nozzle right after imprinting. The nozzle may be very hot.

E Place the ink cartridge shown in the diagram below.

CAUTION

Do not touch the electrical contact on the carriage. Doing so may 
cause a malfunction.

NOTE
Do not use more than one cartridge by rotation. If you do so, applications 
cannot check the ink level precisely.

F Push down the ink cartridge until it clicks into place.

IMPORTANT

Make sure that the ink cartridge lock lever locks the ink cartridge into 
the correct position.

Ink Cartridge 
Lock Lever

If the cartridge does not 
load properly, see step 7.
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G Squeeze the Print Position Adjustment Lever and move 
it to adjust the print position.

Top:
50.5 mm (1.99") from the bottom edge of the document
Middle:
47 mm (1.85") from the bottom edge of the document
Bottom:
43.5 mm (1.71") from the bottom edge of the document

If the ink head drops back when installed, the two ink cartridge 
pins will not fit into the holes on the carriage. Push back the ink 
cartridge lock lever A in the direction of the arrow and reset the 
cartridge in the correct position B.

H Set the ink cartridge.
For more information, see “Setting the Ink Cartridge and Adjusting the 
Print Position,” on p. 16.

I Carefully replace the Imprinter Cover.

J Gently close the Maintenance Cover until it clicks into place.

K Start Windows and log in as a user with administrator privileges.

L Click the Start button, and then click [All Programs], [CANON CR-L1], 
and [Canon imageFORMULA Utility].
imageFORMULA Utility starts.

M Click [CANON CR-L1 USB] and click [Properties].
Scanner properties are displayed.

N Click the [Maintenance] tab and then click [Reset].

Ink Cartridge 
Holes

Ink Cartridge 
Pins
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O Click [OK] to close the scanner properties.

NOTE
You can reset the Residual ink from the Scanning Utility. Click [About], and then click 
[Reset] on the setting dialog box. (See Step 5 on p. 20)

Adjusting the Separation Roller Gap
If double feed should occur too often, adjust the Separation Roller gap 
according to the following procedure.

IMPORTANT
• Make sure that the size, thickness, and weight of your document meets the 

conditions of this scanner. See “Document,” on p. 22.
• Your unit has been carefully adjusted to meet most conditions. However, the below 

adjustment may be needed depending on your environment (humidity, 
temperature, etc.) and the documents you are scanning (checks, etc.). Perform the 
adjustment only if necessary.

A Hook your finger around the open lever and open the Maintenance 
Cover.

B Pull out the document feed tray.

C Load two checks or check-stock paper together.

D Slide the two sheets through between the feeding roller and the 
separation roller and stop at the position shown below.

NOTE
If you were unable to slide both sheets through the gap between the rollers, turn the 
paper thickness adjustment dial counter-clockwise (left) until both sheets two pieces 
easily slide through the gap.

E Gently remove one of the sheets.

Separation Roller

Feeding Roller

Paper Thickness 
Adjustment Dial

Two Sheets
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F Adjust the gap between the feeding roller and the separation roller to 
optimum width.
While one sheet remains in place between the rollers, continuously 
attempt to slide the second sheet (in front of the remaining sheet) to the 
right, back through the roller gap.
Slowly turn the paper thickness adjustment dial clockwise (right) just until 
the second sheet stops feeding into the gap.

IMPORTANT
Turning the Adjustment Dial clockwise too much may damage the rollers.

G Remove the sheets from the paper path and close the Maintenance 
Cover.

H Confirm that the document feeds properly.
See “Confirming Proper Document Feeding,” on p. 24.
If additional assistance is required, contact your local authorized Canon 
dealer or service representative.

I Place a marking label on the unit pointing to the adjustment dial as 
illustrated below. This will serve as a reference point for future 
adjustments if required.

Second sheet does not feed 
into the gap.

Marking labels for thickness 
adjustment dial
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Scanner Specifications

Power consumption

AC Adapter Specifications

■ Use the recommended operating environment for the ink cartridge 
when using the imprinter.

■ You can use the functions noted above if your software supports them.
■ These functions may not work depending on your computer’s 

capabilities and the software you are using.

Specifications are subject to change without notice.

Specifications

Type Desktop sheet-through scanner

Document size Height: 50 to 108 mm (2.0" to 4.3")
Length: 95 to 2,000 mm (3.7" to 78.7")
Thickness: 0.08 to 0.20 mm (0.003" to 0.008")
Weight: 64 to 157 g/m2 (17 to 40 lb bond)

Document feeding Automatic

Scanning method Contact image sensor (CMOS)

Light source LED (CR-L1 UV: UV LED)

Scanning side Simplex/Duplex

Scanning mode Black-and-white, Fine Text Filtering, Error 
diffusion, 16-Level gray, 256-Level gray, 24-bit 
color, UV Scan

Scanning resolution 
(primary scan lines x 
secondary scan lines)

100 x 100 dpi, 120 x 120 dpi, 200 x 200 dpi, 300 
x 300 dpi

Scanning speed
(American checks)

CR-L1: 45 cpm 
CR-L1 UV: 45 cpm (UV Scan mode)

Automatic feeder capacity Load limit of less than 5 mm (0.2") (within the 
load limit mark)

Automatic document feed 
capacity

Up to 50 sheets
(90 g/m2 (24 lb bond))
Make sure stacks do not exceed 5 mm in height 
(including curling)

Interface Hi-Speed USB 2.0

Other functions Infrared double feed detection

Dimensions 140 mm (W) x 223 mm (D) x 188 mm (H)  (5.5" 
(W) x 8.8" (D) x 7.4" (H))

Weight Approximately 2.1 kg (4.6 lb)

Power requirement DC16V 0.9A (excluding AC adapter)

Scanning Sleep mode
Power SW 

OFF

CR-L1 120V
220-240V

15.8W or less 2.3W or less 0.1W

CR-L1 UV 120V
220-240V

15.8W or less 2.3W or less 0.1W

Model number MG1-5042

Input AC 100-240V 50/60Hz 0.57-0.32 A

Output DC16V 1.6A

Weight Approximately 0.2 kg (0.44 lb) (excluding 
power cord)

Noise Less than 64 dB

Operating environment Temperature: 10°C to 32.5°C (50°F to 90.5°F)
Humidity: 20% to 80% RH (20% to 50% RH 
when using the imprinter)
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Safety-related markings on the machine

Marquages de sécurité sur la machine

Marcature di sicurezza sulla macchina

Sicherheitshinweise auf der Maschine

Marcas de la máquina relacionadas con la seguridad

Veiligheidsmarkeringen op de machine

Makine üzerindeki güvenlik i aretleri

[English] Switch (On)

[Français] Commutateur (Marche) 

[Italiano] Interruttore (On)

[Deutsch] Schalter (Ein)

[Español] Interruptor (encendido)

[Nederlands] Schakelaar (On)

[Türkçe] Anahtar (Açık)

Power on

Sous tension

Alimentazione presente

Eingeschaltet

Máquina encendida

Aan

Güç açık

[English] Switch (Off)

[Français] Commutateur (Arrêt)

[Italiano] Interruttore (Off)

[Deutsch] Schalter (Aus) 

[Español] Interruptor (apagado)

[Nederlands] Schakelaar (Off)

[Türkçe] Anahtar (Kapalı)

Power off (no standby current)

Hors tension (pas de courant de veille)

Alimentazione assente (nessuna corrente di standby)

Ausgeschaltet (ohne Ruhestromaufnahme)

Máquina apagada (sin corriente en espera)

Uit (geen stand-byverbruik)

Güç kapalı (bekleme akımı yok)

[English] Switch (Standby)

[Français] Commutateur (Veille) Sous/hors tension (courant de veille activé)

[Italiano] Interruttore (Standby)

[Deutsch] Schalter (Standby) 

[Español] Interruptor (en espera) Máquina apagada/encendida (con corriente en espera)

[Nederlands] Schakelaar (Standby)

[Türkçe] Anahtar (Bekleme)

Power on/off (standby current on)

Alimentazione on/off (corrente di standby presente)

Ein- und Ausschalten (mit Ruhestromaufnahme)

Aan-uit (stand-byverbruik aan)

Güç açık/kapalı (bekleme akımı açık)
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[English] Switch (Push-On/Push-Off)

[Italiano] Interruttore a pulsante 
bistabile (On/Off)

Alimentazione on/off (nessuna corrente di standby)

[Deutsch] Schalter (Ein- und Ausschalten 
durch Drücken)

Ein- und Ausschalten (ohne Ruhestromaufnahme)

[Español] Interruptor (pulsado para 
encendido/apagado)

Encendido/apagado (sin corriente en espera)

Power on/off (no standby current)

Aan-uit (geen stand-byverbruik)[Nederlands] Schakelaar (Push-On/Push-Off)

Güç açık/kapalı (bekleme akımı yok)Anahtar (Bas-Aç/Bas-Kapa)[Türkçe]

[Français] Commutateur (Appuyer pour 
mettre en marche/Appuyer  
pour arrêter)

Sous/hors tension (pas de courant de veille)

[English] Class II equipment 

[Français]

[Italiano] Apparecchio classe II 

[Deutsch] Gerät der Schutzklasse II 

[Español] Equipo de clase II 

[Nederlands] KlasseII-apparatuur

[Türkçe] Sınıf II ekipman

Équipement de classe II 

Indicates this is Class II equipment

Indica che questo è un apparecchio di classe II

Gibt an, dass das Gerät der Schutzklasse II entspricht

Indica que se trata de un equipo de clase II

Geeft aan dat deze apparatuur in Klasse II hoort

Bunun Sınıf II ekipman olduğunu gösterir

Indique qu’il s’ agit d’un équipement de classe II

[English] Heat hazard

[Français] Danger de chaleur

[Italiano] Pericolo: temperature elevate

[Deutsch] Überhitzungsgefahr

[Español] Peligro de calentamiento

[Nederlands] Verbrandingsgevaar

Isı tehlikesi Isı tehlikesi[Türkçe]

Heat hazard

Danger de chaleur

Pericolo: temperature elevate

Überhitzungsgefahr

Peligro de calentamiento

Verbrandingsgevaar
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[Italiano] Protezione dalle cariche 
elettrostatiche 

Evitare di applicare cariche elettrostatiche alla macchina

[Deutsch] Warnung vor elektrostatischer 
Aufladung

Elektrostatische Aufladung der Maschine vermeiden

[English] Electrostatic precaution Avoid applying static electricity to the machine

[Français] Précaution électrostatique Évitez de soumettre cette machine à de l’éléctricité statique

No aplique electricidad electroestática[Español] Precaución electroestática 

Voorkom statische elektriciteit op de machine[Nederlands] Elektrostatische voorzorgen

Makineye statik elektrik vermeyin[Türkçe] Elektrostatik önlemi

[English]

[Français] Symbole CC

DC symbol Indicates direct current

[Italiano] Simbolo corrente continua (C.C.) Indica la corrente continua

[Deutsch] Gleichstrom-Symbol 

[Español] Símbolo CC

[Nederlands] DC-pictogram

[Türkçe] DC sembolü

Indique qu’il s’agit de courant continu

Kennzeichnet Gleichstrom

Indica corriente continua

Geeft gelijkstroom aan

Düz akımı gösterir

[English]

[Français]

[Italiano]

[Deutsch]

[Español]

[Nederlands]

[Türkçe]

DC polarity

Polarité CC

Polarità C.C.

Gleichstrompolarität

Polaridad de CC

DC-polariteit

DC polaritesi

Indicates the power plug polarity

Indique la polarité de la fiche d’alimentation

Indica la polarità  dello spinotto di alimentazione

Gibt die Polarität des Netzsteckers an

Indica la polaridad del conector de alimentación

Geeft de polariteit van de stekker aan

Fiş polaritesini gösterir



CANON ELECTRONICS INC.
3-5-10 SHIBAKOEN, MINATO-KU, TOKYO 105-0011, JAPAN

CANON U.S.A. INC.
ONE CANON PARK, MELVILLE, NY 11747, U.S.A.

CANON CANADA INC.
8000 MISSISSAUGA ROAD, BRAMPTON, ONTARIO L6Y 5Z7, CANADA

CANON EUROPA N.V.
BOVENKERKERWEG 59, 1185 XB AMSTELVEEN, THE NETHERLANDS

CANON AUSTRALIA PTY. LTD.
BUILDING A, THE PARK ESTATE, 5 TALAVERA ROAD, MACQUARIE PARK, NSW 2113, AUSTRALIA

CANON SINGAPORE PTE. LTD.
1 FUSIONOPOLIS PLACE, #15-10, GALAXIS, SINGAPORE 138522

CANON INDIA PVT. LTD
7TH FLOOR, TOWER B DLF CYBER TERRACES DLF PHASE III GURGAON - 122002 HARYANA, INDIA

PUB. 6T3-0039-E1.10 © CANON ELECTRONICS INC. 2018


	Packaging: What Is in the Box?
	Preparation Before Use
	Setting Up the Scanner
	Checking Your Operating Environment
	Installing the Software
	Connecting the Scanner to a Computer
	Turning ON and OFF the Power

	INTRODUCTION
	Table of Contents
	Important Safety Instructions
	Introduction to the CR-L1
	Features of the CR-L1
	Part Names
	Exterior Dimensions
	Preparing the Ink Cartridge

	Software
	How to Use the Software
	Uninstalling the Software

	Document Feeding and Scanning
	Documents
	Document Feeding and Scanning

	Troubleshooting
	When the Scanner Is Not Recognized
	Clearing Paper Jams
	The Scanner Does Not Turn ON
	Feeding Trouble
	When the Scanned Image Is Not Normal

	Maintenance
	Daily Cleaning
	Maintenance
	Specifications

	Index

